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With the last of the HF contests this month for
2023, VHF takes over the mantle until 2024.
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We meet the 2nd and 4th Wednesdays of the month at the Ashley Green Memorial Hall, Ashley Green, HP5 3PP

 Morse Code 
Sadly I’ve come to an end of finding interesting
things regarding Morse code for the newsletter,
should anyone find anything interesting that I’ve not
already covered, please contact me.

 Spotlight 
This month we look at another of
Jeremy’s QSO’s - Almaty, the
largest city in Kazakhstan.

Want to write something for the newsletter?   Then
you can contact me on bryanpage1@btinternet.com

If you want something or have anything for sale, why not
drop me an email and I’ll put it in ‘For sale and wanted’.

Datamodes contesting

Jeremy (G3XZG)

This month we pay tribute to
Jeremy, who passed away

on the 26th of October 2022.

Malcolm (G3ZNU) guides
you through setting up and
using datamodes for
contesting.

Cobweb(b) antenna’s

3 variations + one using a CG-3000 a.t.u.
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If you’re interested in Morse code, here are a few useful links:

FISTS CW Club

Promoting Morse Code for 36 years 1987-2023

https://fists.co.uk

Wikihow How to learn Morse Code

https://www.wikihow.com/Learn-Morse-Code

The Ham Whisperer Morse Code Course 

http://www.hamwhisperer.com/p/morse-code-course.html

LEARN MORSE CODE  LEARN MORSE CODE in one minute !

http://www.learnmorsecode.com/

Welcome to LCWO.net Learn Morse Code (CW) Online!

https://lcwo.net/

Tools for learning Morse Code

https://www.aa9pw.com/morsecode/

Celebrating the unique art form of Morse Code

https://cwops.org/

Morse Code by Ray Burlingame-Goff 
(SK - 29th July 2021)

http://www.g4fon.net/

Morse links

OtherOther
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November 2023

Chairman - Dave Keston (G8FMC) Secretary - Malcolm Appleby (G3ZNU) Treasurer - Matt Whitchurch (M1DTG)

- Guy Plunkett (M0GUY) - James Stevens (M0JCQ) - Peter Holliday (2E0PTH)

- Roger Fellows (M7RMF)

All the above are members of the committee and can be contacted on cdars-committee@googlegroups.com

Editor - Bryan Page (M0IHY)
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My apologies for the delayed newsletter, I’ve been otherwise occupied at
home this month.

With Jeremy (G3XZG) becoming a Silent Key this time last year, I thought it
might be nice to pick a couple of his musings over the years, so I’ve included
“Doppleganger”, which I came across whilst looking up SV1CQN on QRZ.com
(for one moment I thought I was actually looking at Jeremy!), “Snakes and
Ladders” was a game discovered by Jeremy when in a QSO with an Italian
station on CW, maybe we should try it one day. And finally “A story from

Turkey” the tale of someone who ended up looking for himself, not radio related, but interesting
none-the-less.

Thanks to Dave (G8FMC) on his Chairmans Ramble and the article on his VK QSO, Jeremy
(G3XZG) never seems to be far away in our thoughts and day-to-day operations.

The last HF contests this month for 2023 (none in December).

My thanks to Malcolm (G3ZNU) for his excellent article “Operating datamodes in contests (Part 1)”,
step-by-step instructions on how to set up your rig.

With my QRM problems not getting any better I looked up the Internet and found an article by Jean-
Paul Suijs (PA9X), the article is covered on page 8, this tempted me to remove my inverted-L vertical
antenna and use the CG3000 a.t.u. on a 7-band (now reduced to 6) cobweb, it tunes 80m thru 10m,
it just needs thoroughly testing, obviously not as good as my inverted-L but maybe better with the
QRM?

Looking at mag-loops for portable operation I came across an article by the Richmond Amateur
Radio Club of Virginia, it covers 40m-10m continuously, and is based on the Chameleon “P”
commercial model, other models had been checked out to clone but this one (in their opinion) was
the best of the bunch, this is my ‘winter’ project with minimal cost (I have most of the components in
my shack), more on that in another newsletter.

Unfortunately I’ve come to an end when trying to find different interesting articles for the CW Corner
page, reluctantly I have to go to press this month with no CW Corner, should anybody want to
investigate Morse code for a newsletter article please let me know.

Next month’s edition is the Christmas edition, every year I try to find something amateur radio-wise
such as a little ditty and so far I’ve been successful, how about you the readers chipping in for the
next edition with Christmas poems, or stories relating to amateur radio at Christmas, it would be
much appreciated.

And lastly, with storm Cairan looming make sure your antenna’s are secured correctly.

Bryan M0IHY

Welcome

Bryan M0IHY

RegularsRegulars
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(A tribute to Jeremy G3XZG, with much respect and fond memories from around the
World) 

Well last months HF contest session with ‘guest operators’ at my shack seemed to go
rather well and was thoroughly enjoyed by all.

There was another event coming up on the weekend of 30th Sept - 1st October.  This
was a re-vamp of the RSGB DX contest, now run by the UKEI CC group.  I decided to
again make my shack available to anyone interested to have-a-go on HF with full
power. 

Mark M7EFR was available this time and was interested to witness ‘what goes on’ in
an HF contest.  No other takers, so Roger M7RMF Jumped in for another session as well.  Roger arrived early
to help me put up the Cobweb for 10m, 15m and 20m, this time on my patio as we did not need to provide
separation from the VHF antennas.

Roger and Mark enjoyed the afternoon making contacts with various parts of the world, mostly on 20m and
40m, with Roger staying into early evening.  Mark was due Sunday morning for a while, primarily to help me
‘break-camp’ so to speak.

So although not a serious entry I had a bit of a bash myself on Saturday evening.  

Awaking early(ish) Sunday I decided to see what was on before getting breakfast.  Flicking over to 20m I
found the band wide-open to VK (Australia).  None of the stations were giving contest-points, so I did not want
to pester them.  Looking at the clock I decided I needed to have some breakfast and get dressed before the
‘morning-shift’ arrived!  Whilst preparing breakfast I heard another station; VK3CWB calling CQ almost exactly
on my RX frequency.  A quick sprint next door and a touch on the tuning knob and Moz was 5and9 + 10dB.
Another EU station went back to him before I could sit down and they had a fairly short QSO.  “VK3CWB CQ”
and I jumped in with G3MDG.  Moz responded immediately with a 5and7-8.  He then said “G3MDG sounds
familiar, have we worked before, maybe on CW?”  Ah, not me but maybe Jeremy G3XZG?  It turns out that
Moz had been in touch with Jeremy on several occasions, mostly on CW, using both G3XZG and G3MDG and
had wondered why he had not heard him lately!  I conveyed the sad news about Jeremy having gone SK
before his time, almost exactly a year ago.  Moz was very sorry and asked for me to covey his condolences to
Jeremy’s family.  Hilary will be getting a copy of this ‘Charman’s Ramble’.  A sobering and slightly emotional
experience for me.  We have such fond memories of Jeremy and he is sadly missed by so many.  I am doing
my best to follow as Charman, but am not in the same league as Jeremy. 

What are the odds of the 20m band being wide-open to VK and to hook-up with someone who usually uses
CW and knew Jeremy?  I would imagine several million to one? 

For me that is what Amateur Radio is all about; world-wide friendship.

I then had a scramble to have breakfast and get dressed before Mark arrived.  I almost made it, still doing
buttons up as I answered the door, which gave Mark something to chuckle about!  

Lots of changes going on at G8FMC QTHR:
Changed car to something more suitable for the medium-term, that I can easily get in and out of even in a tight
car-park, when my iffy back is not so good!
Had all my windows replaced.  The old ones were 20+ yrs old, of variable and dubious quality, some with an
awful installation that did not seal properly.  All cosy now!
Getting more involved with the local community and people outside of Ham Radio, now that I am not tied
down as a 24/7 carer.

73 all, Dave K, G8FMC (Chairman and Contest Coordinator) 

Dave (G8FMC)

Chairmans Ramble

RegularsRegulars
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I thought it would be appropriate to look back on a couple of interesting items about/from Jeremy, so here
goes.

Doppleganger

While checking out the locator for SV1CQN I came across his picture, I had to do a double take as the
resemblance to Jeremy (G3XZG) is quite remarkable.  They do say we all have a ‘double’ somewhere.

Bryan M0IHY

Snakes and Ladders

I recently had a slightly surreal QSO with an Italian station on CW. This was on 10 MHz and I was surprised
when he asked if I knew my maidenhead locator, as that is not often used on HF.  I did, and he explained that
he needed it for a game of snakes and ladders run by EU CW. Apparently  squares can be either snakes or
ladders, or just normal squares and greater London, particularly JO1 is usually a snake. Ladders in the UK,
tend to be in Scotland where less people live I guess. 

This got me thinking, with Christmas being the traditional time for family games, whether any other games
could be adapted for amateur use. 

Jeremy G3XZG

TributeTribute
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One possibility is Cluedo. I could picture a game in which G3ZZZ was found murdered in the shack, using an
AR88. There are a number of flaws in this idea of course. All radio amateurs would be murdered in the shack.
Suspects would be limited to those who could actually lift an AR88 and anyway the prime suspect would
always be the ham’s partner. So I discarded that idea. 

Monopoly is another possibility. You could progress round the board with rarer DX countries having higher
value. Say France and Germany could be at the beginning, graduating to some of the more esoteric islands
rather than Park Lane and Mayfair. 

Devising Community Chest and Chance cards would not be too much of a problem. 

Examples. 
You are stuck in a pile-up trying to work a station in Uganda, miss three turns. 

You are informed by another amateur that your signal is spreading, go two squares back, while you fail to find
out why and decide to carry on. 

You increase power to the point where the nearest lamppost comes on when you key up, go forward 3
squares. 

You erect an antenna without realising that  it requires planning permission. Either miss two turns, or just keep
going, but be aware that if you do, your opponents can choose when you miss the turns.

But then I hit the problem of what to do with the corners. Go to gaol didn’t seem appropriate somehow, nor
free parking. 

In the end I decided that the only thing to do was to try and invent a game. This would be called “full licence”
and players would compete to move round a board, first obtaining a foundation, then intermediate, then finally
a full amateur licence. 

Various pitfalls could be introduced, such as, in current circumstances, the internet failing part-way through
your exam, the antenna that you erect on getting your foundation licence, collapsing on to the garden shed,
Your neighbours going on to a government website and reporting that you are contacting aliens, etc. 

There would of course be quicker progress for those who learned CW. 

Sadly that is as far as my invention has gone at the moment and I don’t think I will be suggesting to the RSGB
that it is a good way of marketing the hobby. 

I must find out more about this Snakes and Ladders game though. 
Jeremy, G3XZG

A story from Turkey

Finally, and nothing to do with radio, a story from Turkey caught my eye. A man who lives in the south-east of
the country had spent a convivial and long evening drinking with friends. He was making his way, meandering
and mellow, towards his home through a small forest when he came across was what evidently a search party
and thought he should volunteer to join in and help, which he did. After a little while and responding to shouts
from one of the other members of the group, he realised that he had spent the last half-hour or so helping a
search party who were looking for him. Apparently his wife had become worried when he did not return home.
The police took him home, and I expect the conversation would then have been interesting.

Jeremy, G3XZG

TributeTribute
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A different approach to tuning the Cobwebb antenna

Source: Jean-Paul Suijs - PA9X

The Cobwebb is an antenna that has gained in popularity in recent years. The horizontally polarized
omnidirectional antenna is suitable for the 10m, 12m, 15m, 17m and 20m band. All elements are fed through
one single feed line. At only half wave length above the ground, it will outperform any vertical antenna.
Measuring only 2.8 by 2.8m, the Cobwebb is the solution for the DX’er with limited space. But the Cobwebb
design has some disadvantages: it’s narrow bandwidth and tuning it to a acceptable SWR.

The three variants of the Cobwebb antenna

The Cobwebb antenna comes in three variants:

No.1: The G3TPW from Steve Webb is the original design of the Cobwebb. The elements are folded dipoles
with open ends, usually made from figure 8 speaker wire. Exactly in the middle of the folded dipoles, the two
parts of the dipole are interconnected. This shorting point creates a kind of T-match to bring the impedance to
50 ohms.

Cobweb antenna’s

A Cobwebb original design antenna. Notice the the short circuited points about halfway each element, this is

the most challenging to tune, it has improved bandwidth (approx. 15%) than the G3TXQ variant.

RegularsRegulars
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No.2: The G3TXQ variant from Steve Hunt (sk), also called Cobweb (with one letter ‘b’), uses open dipoles,
single wires. The impedance is brought to 50 ohm by means of a 4:1 balun. It is the most commonly built or
purchased Cobweb and commercially available variant (like MFJ, EAntenna).

The Cobweb uses single wire open dipoles. The feedpoint box holds a transformation balun combined with a
a common mode choke. Image from G3TXQ.

The G3TXQ is a lot easier to tune, but in terms of bandwidth the G3TPW offers about 15% more.

RegularsRegulars
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No.3: I call this third variant the Multiband Square Halo, based on the classic Halo design. It uses closed-
ended folded dipoles, also from figure 8 speaker wire. This is the same principle as the classic Halo antenna,
known from VHF. The impedance of this variant is 50 ohms and therefore does not need matching. Thanks to
the closed-ended folded dipoles, the Square Halo offers about 15% more bandwith over the G3TXQ Cobweb.

The Haloweb uses folded dipoles with closed ends for increased bandwith.

Square Halo, the best of both worlds

I built all three variants. They are almost identical in construction. The G3TPW is the most challenging in terms
of tuning. That is because in addition to tuning by means of the element lengths, also the shorting points have
to be moved. The G3TXQ is a lot easier to tune, but in terms of bandwidth the G3TPW offers about 15% more
bandwith. The variant with probably the best of both worlds is the Square Halo. This Cobwebb variant
combines the bandwidth of the G3TPW, with the ease of tuning like the G3TXQ.

Choose between Phone and CW section of the band

The bandwidth of the Cobweb (with the one letter ‘b’) is limited. At 20m and 15m it is about half the band and
at 10m no more than 500kHz. When tuning to 20m, for example, you have to choose between the “Phone”
and “CW” section of the band. You would need a tuner to increase bandwith with an acceptable SWR.

RegularsRegulars
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A test of your patience

There is another ‘challenging property’ to all three variants. That is the 50 ohm adjustment of all elements to
resonance and SWR when using the 5-band version. This is truly a test of your patience. With an MFJ-259B
analyzer in hand I managed to get all bands resonant, but in no way did I get the SWR to an acceptable level
< 2:1. In all variants I only got the 20m element resonant with a good SWR. All other elements were all above
2.5:1 SWR.

My challenge with multiband antennas

Now I have always had a ‘tuning challenge’ at my location. For example, I was never able to get my Hustler
5BTV trap vertical to an acceptable SWR on 15m band. I also never got a homemade WARC vertical for 12m
and 17m adjusted to a decent SWR. It must be the location. I suspect that some metalwork in the roof of my
house is the cause.

The best way to adjust impedance

Since I got all the elements resonant, I thought it was a shame to not use those bands on because SWR was
bad. The solution is to tune each element separately for those bands, for example via the built-in tuner in your
transceiver. But that results in a lot of loss in your coax cable, especially on long runs. The best way to match
impedance is to do as close as possible to the feedpoint of the antenna.

CG-3000 automatic antenna tuner

Now I have worked with a 13m long vertical antenna for a long time. I used to tuned it with a CG-
3000 automatic antenna tuner directly at the feedpoint the vertical. This antenna was quite a good
performer in transmitting from 60m band up to 17m band. But the local noise was always awful. As a
receiving antenna it performed rather poor.

With the dismantling of this antenna, to make room for my Square Halo, I had the CG-3000 remote
tuner laying in the shack, doing nothing. So I decided to put it up in the Halo and experiment with
tuning that antenna.

The CG-3000 autotuner tunes form 160m to 10m handling 200 watts PEP.

RegularsRegulars



November 2023 - CDARSPage 12

The tuner at the feedpoint of the Square Halo

With some pieces of aluminum from my scrap metal collection, I made some brackets and mounted the tuner
where normally the feedpoint would be mounted. The tuner itself weighs about 2kg. Not too heavy to put it on
the boom. The extra bandwidth with folded dipoles is canceled out now by the tuner, so I presumed open
dipoles would do fine and would reduce total weight. So I stripped the folded dipoles to open dipoles. When
determining the wire lengths, I took the length of the internal wiring of the tuner (approx. 20cm) into account.

ZL with 25W FT8 on 20m band via long path

As I expected, I could now tune the antenna to any frequency on 10m, 12m, 15m 17m and 20m. After about
four weeks of testing with WSPR and FT8, I could not notice any significant difference in performance
compared to the Square Halo for 20m, 17m and 15m. For example, ZL with 25 watts FT8 on 20m band via the
long path, went quite easy. But it seems that 12m and 10m are performing less good in RX, however it’s a gut
feeling still. Is suspect that radiation pattern is disturbed on these bands. PA0JBB Hans mentioned in a post
that the power supply cable of the tuner could be participating as active part of the antenna. Something I need
to research.

ZL via the long path end of April 2021 using 25 watts in FT8.

The CG-3000 remote tune at feedpoint of the Cobweb antenna.

RegularsRegulars
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Surprised me in a positive way

I found the combination of Cobweb antenna with autotuner, a successful setup to solve my impedance
matching issue. It also allows me to work each earlier mentioned band entirely. I only need to retune when it’s
close to band edges. In terms of performance this setup surprised me in a positive way.

Easily tune it on all other HF bands

Although the Cobweb antenna is not built for other bands, the CG-3000 can tune it on all other HF bands as
well. The tuned Cobweb did surprisingly good at 30m. Even on 160m band with 25 watts I was received in
more places in FT8 than ever in the past with the 13m long vertical with auto tuner.

The Cobweb tuned to 160m band outperforming the 13m vertical

Test with folded dipoles for less noise?

Nevertheless, I am also going to test with the folded dipoles. These would be less sensitive to manmade QRM
than the open dipoles, some say… I have plenty of manmade noise to test it in practice.

My (M0IHY) approach to the Square Halo

I replaced the original dipoles with figure of 8 speaker wire, but instead of shorting out on the long side of the
dipole (as in the G3TPW Cobwebb), I shorted them out at the very end (as in the Square Halo). The length of
each dipole was the same as the original single-wire (as per G3TXQ dipoles), Initially I wasn’t too worried
about being ‘exact’ as I was going to use my CG-3000 a.t.u., which I mounted on the mast, just below the
Cobweb, however, since testing I can only tune from 80m-10m, maybe tuning each dipole for the best SWR
before connecting to the CG-3000 might help.

As yet I have to test it and see if it handles the QRM from my neighbours house, fingers crossed.

Bryan M0IHY

RegularsRegulars
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VHF Championship – AFS (Affiliated Societies) section;
Still 2nd place out of 86, just awaiting the results of the final 23cm & 13cm events, to see if we can still hold
2nd or if Sheffield have overhauled us?  

The 144MHz Trophy results were very satisfactory, enabling us to hold the 2nd spot comfortably.  John
G0ODQ bagged 2nd spot in the 6hrs Single Op fixed spot category, well done John.  Our combined effort at
G8FMC got 19th out of 31, pretty much as expected for a part-time training exercise & with my poor/screened
take-off to the EU.  

The UKAC’s (under the Northampton banner): We should hold 3rd place out of 43 until the end of the year, as
4th is some way behind us? 

Dave’s Delta-loop experiments continue, during UKEICC DX contest at G8FMC:
Yet another opportunity to compare the Delta-Loop with my Cobweb, during the UKEICC contest of 30th Sept
- 1st Oct.  (Cobweb in a slightly different location this time)

For this event Roger M7RMF again helped me set-up & operate.  Mark M7EFR also came over for some HF
experience.  (See my Charman’s Ramble at the beginning of this News Letter.)  Again there was very little
difference between the 2 antennas most of the time.  My lengthy chat with Moz VK3CWB included a direct
comparison between the two, with negligible difference.  So if I can get a few more bands on the Delta-loop
we could be in business.  One benefit is the very broad bandwidth, negating the need for an ATU, once
optimised. 

The SSB FD (Fixed station) results are published and we achieved a very respectable 10th out of 48 in the
Fixed category.  Since it was a part-time training session & with resources split between HF & 144MHz, I think
this is rather good?  Well done Roger M7RMF & Matt M1DTG for your contributions.  (A reasonably well
equipped shack & choice of antennas helped?)

Affiliated Societies (AFS) Superleague: 
This started with the 70MHz event on 17th Sept.  We fielded a team of 6 & the top 4 of G0ODQ, G0SKA,
G8FMC & G3MEH, secured 3rd place behind Camb-Hams & Grimsby (the ‘usual suspects’!).

The 50MHz was on Sun 22nd, when we again had 6 on, although 2 part-time. 

The next one is the ‘Club Calls’ (160m) event on Sat 11th November when we hope to have a team possibly
at the Ashley Green Hall using the club call of G3MDG? 

I expect to have a full size Dipole in the paddock behind my garden (must remember to ask permission again!)
which has produced great results in the past. 

73, Dave K, G8FMC 

Contests/Operating

RegularsRegulars
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At a recent CDARS meeting at Ashley Green I demonstrated using data modes – specifically RTTY and
PSK63 – in contests. I covered how to set up a station – which software to download and configure – and how
to make contest QSOs. This article will cover setting up a station to operate on RTTY and PSK63. It will also
cover setting up full CAT control of the radio by the PC, always best if you can so that the radio and PC
software are keeping in step with one another. Operating in a contest is really a matter of practice and is best
learned “on the job”, and a subsequent article will cover what I’ve learned from operating in RSGB and
CQWW datamodes contests.

I’m going to describe my setup of a Windows PC connected to a Yaesu FTdx10, but many of the descriptions
will apply to other rigs. Where possible I’ll set out what to look out for when starting out with your own rig.

Most (if not all) recent transceivers need only a single USB connection between PC and radio that provides
audio and control connections. This makes the connection very easy physically, and pushes all the complexity
into the software and its configuration. Older radios will need some way of interfacing the audio paths and, at
a minimum, TX/RX switching. One convenient way of doing this is to use a Tigertronics SignaLink – but more
on that later.

INSTALL DRIVERS: Before you connect your radio and PC you will need to install drivers on your PC so that
it will recognise the radio and know how to talk to it. It’s best to head to the manufacturer’s website to find
these – generally look for the support pages and you find the appropriate drivers to download and install. It’s
quite possible that the drivers will be the same for different manufacturers – in my case it appears that the
drivers for the FTdx10 were the same as those for the Icom IC-9700, but don’t take my word for it, find the
right ones just in case!

Once the drivers are loaded (you may need to restart the PC) plug in the USB. The PC will then do two things
– it will set up one (or more) serial ports and the equivalent of an external sound card. We’ll now look at how
to find what the PC did, and to identify the serial port numbers and the identity of the sound card.

LOCATE YOUR PORTS: To find what ports the PC has installed, start the Windows Device Manager – click
on the Windows Start button and type “device”, and click on Device Manager. Click on the little arrow to the
left of the word “Ports” and it will open up a list of the active ports on the PC. 

There may be one or two entries in the list that relate to your radio. For the FTdx10 there are two – one
labelled “Enhanced” (Port 3 in my setup) which carries the main CAT control data, and another labelled

Operating datamodes in contests (Part 1)
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“Standard” (Port 5 in my setup) which can be used to carry CW keying and TX/RX switching. Your port
numbers may be different, so make a note of which port is which as we’ll need this later.

If it’s not clear which are the correct ports, unplug the USB and plug it in again – the ports will be “uninstalled”
and “reinstalled” each time so it’s easy to see the ones you need.

LOCATE YOUR SOUND CARD: Next start up the Windows Sounds control panel. I find the legacy panel
that’s part of Control Panel easier to use than the new “Windows 10” Settings. To get to it, click on the
Windows Start button and type “control”, and then click on Control Panel. If there’s only a few items listed you
are in Category mode, so head towards the top right of the Control Panel screen where it says “View by:” and
select Small Icons from the drop-down list. Much easier! Now click on Sound, and the Sound control panel will
open up.

Clicking the Playback tab at the top shows the settings sent from the PC to the peripheral devices (the left-
hand image above). On my setup you can see that there are several audio devices enabled; the radio is listed
as “5 – USB Audio Codec”, the ones labelled PL2493H are the two HDMI screens plugged into the PC. You
want to select the radio connection as the “Default Communications Device” – right mouse click on that entry
and you should be able to select that option. Don’t select “Default Device” or all the system audio will also be
sent to the radio! It may take a few right mouse clicks on the devices to get this right – be patient and try
different options until you get it right.

Now click on the Recording tab at the top (the right-hand picture above) and select the connection to the radio
(also 5 – USB Audio Codec) as the Default Device. You want this to be the Default Device (rather than Default
Communications Device) so that the PC is only listening to that interface and not (for instance) the built-in
microphone.

At some point you might need to adjust the sound levels on send or receive. If that’s the case double-click on
the entry you want to change and it will bring up the Properties panel where you can adjust levels up or down.

LOAD THE SOFTWARE: Now all the PC to radio connections are sorted, we’ll move to the software you
need. There are two key programs – the N1MM+ logger and the Fldigi modem/codec. Download and install
both – a web search will find them both, and make sure you install them in the default directories offered.

Start N1MM+ - it will almost certainly tell you there is a new version available, even if you’ve only just
downloaded it! Click on yes and wait for it to download the latest update and restart – this might take a minute
or two with little indication anything is happening, so be patient.

CREATE AN N1MM+ DATABASE: in common with many logging programs, N1MM+ stores all its data in a
database. So the first thing you need to do is create a database. With N1MM+ running, click File -> New

Database. A dialogue box will open up, choose a name for your database – I suggest putting your callsign in
there somewhere and maybe the date – and click Save. You can store any number of logs (one for each
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contest you operate in) in a single database, so you won’t need to create a new database in the future unless,
for instance, you’re using your PC for a club contest.

CONFIGURE N1MM+: Once N1MM+ is running you can set up your station information – click on Config ->
Change Your Station Data and fill in the details. After clicking OK, click Config -> Configure Ports, Mode
Control, Winkey etc. On the config screen that pops up, select the COM port number you found previously and
the radio type you have in the drop-down boxes (in my case, COM3 and FTdx10). Then click the Set button to
bring up the detailed settings for that port. Here you can set the data rate for the COM port, parity, number of
stop bits etc. Helpfully some suggested settings are in the box at the bottom, N1MM+ is quite good at this.

In my setup COM3 carries the main CAT control data, and COM5 carries the PTT keying, so you will see that
the next entry in the configuration screen is COM5. I’ve clicked the CW/Other box to tell N1MM+ this is not a
general CAT control. Then click Set.

To make the PTT keying on the FTdx10 work I have set DTR to Always On, and the RTS to PTT. If you’re not
sure of your own radio’s settings, a web search will probably find the answer.
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The last thing to set up in N1MM+ is to tell it how to start up Fldigi when using datamodes. On the
configuration screen click on the Digital Modes tab. On the Digital Interface TU Type select Soundcard, and in
the Fldigi Path enter the address of the Fldigi program you’ve installed. There’s a handy Select button that
brings up an Explorer window so you can navigate your way to the install directory. A warning here – if you
update Flgigi it irritatingly puts it in a new directory so you’ll need to update this field each time. 

TEST IT OUT: If it’s not already running, start N1MM+. You now need to tell N1MM+ to set itself up for a
datamodes contest. Click on File -> New Log in Database and a dialogue box opens up. N1MM+ “knows”
about a vast range of contests from countries across the world plus the big international events such as
CQWW. The trouble is, it doesn’t know about all the details of some of the more parochial contests (such as
RSGB ones!) so you’ll need to adjust some parameters. 
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In the top drop-down box, select RSGB80MCC – that’s a basic setup for the RSGB evening series contests. In
the following drop-down boxes, select:

Operator: SINGLE-OP
Band: ALL
Power: LOW (that’s 100w)
Mode: DIGITAL
Overlay: N/A
Station: FIXED
Assisted: NON-ASSISTED (not very important anyway)
Transmitter: ONE
Sent exchange: # (this is important)
Operators: Your callsign

Then click OK. You’ve told N1MM+ you want to operate digimodes, so it will start up the digital interface. If it
doesn’t then click Window -> Digital Interface and that should do the trick.
 
It’s possible that the default modem/codec in your setup is not Fldigi, but MMVARI (an alternative that I’ve not
really used). To make sure you’re using the right one, click on Interface and select Fldigi.

If all is well, your digital interface panels should look like this:
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The panel at the top shows the decoded data received and will also show the data you send. The panel below
shows a waterfall of the received audio and also has the settings for selecting the data mode you are using.
As shown here, it’s set to RTTY 45.45 baud – to change this click Op Mode and a drop-down list appears with
all the modes that Fldigi supports. The main two you need are RTTY 45.45 and PSK63 – these are the ones
used in most contests.

In the waterfall display above you can see the blue trace of an RTTY signal, with the two tones clearly
showing. The red lines indicate the actual frequencies that Fldigi is decoding – you move your mouse until the
red lines are on top of the required signal and click, and Fldigi gets to work. When you transmit you will send
at exactly the same tone frequencies, so you’ll respond to a station exactly on the right frequency.

You can check if the TX/RX switching is working by clicking on the TX button on the digital interface panel –
but make sure you are on an unused frequency or into a dummy load first! If all is well your transmitter should
produce power; if not you may need to adjust your audio levels in the Sounds control panel. If your radio does
not go into transmit mode you may need to make some changes to the CAT interface settings. If in doubt,
start with a Google search – someone somewhere will have had the problem before!

NON-USB RADIOS: Earlier I mentioned about what to do if your radio does not have a USB interface. My
Kenwood TS2000 is like this. It does have an accessory socket which gives access to audio in and out, but
when connecting up you may well find that PCs and radios don’t mix too well. Typically when transmitting
there will be stray RF on the cables which tends to crash PCs, or at least their interfaces. One way to avoid
these problems is to use an interface that someone has designed and built – such as the Tigertronics
SignaLink I mentioned earlier. This unit plugs into your PC via a USB lead (from which it gets power too) and
has a range of leads to connect to radios. Inside there’s a strappable header that can be set up to support the
interface to many radios. It has isolating transformers for the audio connections and opto-isolators for the
control signals, so you’re unlikely to have RF problems. 

Although my TS2000 doesn’t have a USB socket, it does have an RS232 socket for CAT control, so I have an
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interface lead for that into my PC too. One curiosity with the TS2000 is that if you tell the radio to go into TX
via the CAT interface, it always takes audio from the mic socket on the front! A known limitation. Fortunately
the SignaLink has provision to key the TX via the accessory socket using a VOX circuit built into the
SignaLink, so when the PC sends audio, it keys the TX.

COMING UP NEXT: If all is well you now have a working setup to run the RTTY and PSK datamodes in
contests. Next month I’ll give some more information on operating in a contest, including all the shortcuts that
make using N1MM+ as not just a logging program, but also the core of your operating.

Malcolm G3ZNU
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Source: Wikipedia

Almaty is the largest city in Kazakhstan, with a population of over 2 million. It
was the capital of Kazakhstan from 1929 to 1936, while the country was an
autonomous republic of the Soviet Union, then from 1936 to 1991, a union
republic and finally from 1991, an independent state. In 1997, the government
relocated the capital to Akmola (present-day Astana).

Almaty is still the major commercial, financial, and cultural centre of
Kazakhstan, as well as its most populous and most cosmopolitan city. The city
is located in the mountainous area of southern Kazakhstan near the border with
Kyrgyzstan in the foothills of the Trans-Ili Alatau at an elevation of 700- 900 m (2,300-3,000 feet), where the
Large and Small Almatinka rivers run into the plain. The city, just like Astana and Shymkent, does not belong
to any region and is officially a “city of state importance”.

The city has been part of the UNESCO Creative Cities Network in
the area of music since November 2017. The city was the host for a
1978 international conference on Primary Health Care where the
Alma Ata Declaration was adopted, marking a paradigm shift in
global public health.

Theatrical art began to develop in the city of Verny a few years after
the construction of the Russian fort. On 21 November 1872, the
Society of Dramatic Art Lovers staged the first production in the city:
A. N. Ostrovsky’s play, “Stay in Your Own Sled”. Later, plays were
performed at public, military, and commercial gatherings. An
abridgement of Glinka’s opera “A Life for the Tsar” was the first
opera staged in the city, by the Kolpakovsky three-year city school
on 23 February 1913 at the Commercial Assembly, to
commemorate the tercentenary of the Romanov dynasty.

The flowering of theatrical art in the city began during the Soviet period of
Alma-Ata, resulting from the transfer of the capital of the Kazakh Soviet
Socialist Republic from Kyzylorda to Alma-Ata. Thus, the Kazakh Drama
Theater, the first Kazakh professional theater, moved to the city. In the
1930s, the Opera and Ballet Theater (1934) and the Puppet Theater
(1935) were established in the city. Also, theater companies founded in
different cities of the republic began to move to the capital: the Russian
Drama Theater (moved from Semipalatinsk in 1934), the Uyghur Musical
Comedy Theater (from Chilik, 1962), the Korean Musical Comedy
Theater (from Kyzylorda, 1968), and the German Drama Theater (from
Temirtau, 1989).

After Kazakhstan regained independence in 1991, a large number of new independent theaters appeared in
the city. Often these are modern youth concert venues created by enthusiasts. They face funding problems,
as maintaining a permanent theater company is costly.

Band: 20m QTH: Almaty, Kazakhstan

Mode: CW Coordinates: 43°16'39"N 76°53'45"E

Date: 27th March 2022 Time Zone: UTC+6

Time: 12:00z Population: 2,147,233 (October 2022)

QSO with Gennadiy V. Khonin, UN7QF

Spotlight - Almaty, Kazakhstan

Flag

Coat of arms

The International conference on Primary
Health Care in 1978, known as the Alma-
Ata Declaration

Abay Opera House
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The First President’s Park is an urban park located in Almaty at the intersection of Navoi Street and Al-Farabi
Avenue in the Bostandyq District. The park was opened in July 2010.

Creation of the park began in 2001. The park is broken into three main areasâ€›the avenue, boulevard, and
dendrological areas. Greenery was planted according to dendrological plan. In honor of the participation of
the city of Almaty in the Olympic torch relay of the Beijing Olympic Games, approximately one hundred
spruces and birches were planted. In 2011, a hundred Tien-Shan spruces were also planted. Plans include a
set of water projects over an area of 9.5 hectares.

Almaty remains the largest, most developed, and most ethnically and
culturally diverse city in Kazakhstan. Due to development by the Soviet
Union and relocation of workers and industries from European areas of
the Soviet Union during World War II, the city has a high proportion of
ethnic Russians and Uyghurs. The city lies in the foothills of Trans-Ili
Alatau (or Zailiysky Alatau) in the extreme south-east.

It has a relatively mild climate with warm and dry summers and quite cold
winters. Since the city is in a tectonically active area, it has an endemic
risk of earthquakes. Although most tremors do not cause any significant
damage, Almaty has suffered some large destructive earthquakes.

The name Almaty has its roots in the medieval settlement Almatau, that
existed near the present-day city. A disputed theory holds that the name
is derived from the Kazakh word for ‘apple’, and is often translated as
“full of apples”. Originally it was Almatau which means Apple Mountain.

There is great genetic diversity among the wild apples in the region
surrounding Almaty; the region west of the Tian Shan mountains is
thought to be the apple’s ancestral home. The wild Malus sieversii is
considered a likely candidate for the ancestor of the modern domestic
apple

Jeremy G3XZG

Zenkov Cathedral, a 19th-century
Russian Orthodox cathedral located
in Panfilov Park, is the fourth tallest

wooden building in the world.

Entrance to the First Presidents Park, 2010

Panoramic night view of Almaty from Kok-Tobe, 2012
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Contest Corner

November
HF

Day Date (2023) Time UTC Contest Name

Mon 06 Nov 2000-2130 Autumn Series DATA

Sat 11 Nov 2000-2300 Club Calls (1.8MHz AFS)

Wed 15 Nov 2000-2130 Autumn Series SSB

Sat 18 Nov 1900-2300 2nd 1.8MHz Contest

Thu 23 Nov 2000-2130 Autumn Series CW

Mon 27 Nov 2000-2130 RSGB FT4 Contest

VHF
Day Date (2023) Time UTC Contest Name

Wed 01 Nov 1700-2100 144MHz FT8 AC (4 hours)

Wed 01 Nov 1900-2100 144MHz FT8 AC (2 hours)

Sat-Sun 04-05 Nov 1400-1400 144MHz CW Marconi

Tue 07 Nov 1900-1955 144MHz FMAC

Tue 07 Nov 2000-2230 144MHz UKAC

Wed 08 Nov 1900-2100 432MHz FT8 AC (2 hours)

Wed 08 Nov 1700-2100 432MHz FT8 AC (4 hours)

Thu 09 Nov 2000-2230 50MHz UKAC

Tue 14 Nov 1900-1955 432MHz FMAC

Tue 14 Nov 2000-2230 432MHz UKAC

Thu 16 Nov 2000-2230 70MHz UKAC

Tue 21 Nov 2000-2230 1.3GHz UKAC

Tue 28 Nov 1930-2230 SHF UKAC

December
VHF

Day Date (2023) Time (UTC) Contest Name

Sun 03 Dec 1000-1400 144MHz AFS

Tue 05 Dec 1900-1955 144MHz FMAC

Tue 05 Dec 2000-2230 144MHz UKAC

Wed 06 Dec 1900-2100 144MHz FT8 AC

Tue 12 Dec 1900-1955 432MHz FMAC

Tue 12 Dec 2000-2230 432MHz UKAC

Wed 13 Dec 1900-2100 432MHz FT8 AC

Thu 14 Dec 2000-2230 50MHz UKAC

Tue 19 Dec 2000-2230 1.3GHz UKAC

Thu 21 Dec 2000-2230 70MHz UKAC

Tue 26 Dec 1400-1600 50MHz Christmas Contest

Wed 27 Dec 1400-1600 70MHz Christmas Contest

Thu 28 Dec 1400-1600 144MHz Christmas Contest

Fri 29 Dec 1400-1600 432MHz Christmas Contest
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For sale and wanted
If anybody has anything for sale, or wants anything, then this is the place to ask, photo’s and descriptions will
help, email me at bryanpage1@btinternet.com.

RegularsRegulars



November 2023 - CDARSPage 26

Any other business
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